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Lecture - 26
Process Capability Analysis: Minitab Application

Hello friends, I welcome you to the ongoing six sigma journey and if you recall we were
discussing Process Capability Analysis in the last two lectures. So, we have covered the
various concepts and process capability indices. Now in this lecture 26, I would like to

share the mini tab application of process capability analysis.

So, mini tab is a widely used software for conducting various kinds of statistical analysis
and this software is widely used for say doing the various kinds of analysis as a part of
six sigma. So, I will just try to show some brief application of mini tab for conducting

process capability analysis.

(Refer Slide Time: 01:11)

So, once again I would like to remind you that a bad system will beat a good person
every time, this is said by the renowned quality guru W Edwards Deming and we must
have a capable system capable process. So, that we do not unnecessarily take the

corrective exercise in the wrong direction.
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Recap

QProcess Capability and Capability Indices
QProcess Performance and Performance Indices
QShort-term and Long-term Capabilities
UCapability Related Assumptions

UConducting a Process Capability Study
UNatural Process Limits and Specification Limits
UProcess Performance Metrics

If you see the brief then we talked about short term process capability, long term process
capability, process capability indices, process capability concepts, process performance
and we are also seen that traditionally whatever we have seen DPMO DPU and defect
related measures specific six sigma measures they are different than process capability
measures or indices. And we have seen that Cp is basically indicates the potential of the
process CPKI Cpk performance of the process, then you have CPU, CPL if you are
targeting only one specification limit and same way you have Pp Ppk PPU PPL typically
when you are considering a long horizon over which the process is absorbed and for long

term when you are conducting the process capability analysis.
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Concepts Covered:
Usteps to conduct process capability analysis in

Minitab

CONCEPTS COVERED

OMinitab Process Capability Analysis

UExample with demonstration to use Minitab

&
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So, typically in this particular session which deals with the mini tab application, we will

try to appreciate these steps to conduct process capability analysis, mini tab process

capability analysis, examples, some demonstrations and like this.
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Steps to Conduct Process Capability
Analysis in Minitab

Step 1: Go to File menu, click on Open Project and then load the

required data.

Step 2: Go to Stat menu, move to Quality Tools and then to Capability

Analysis or Capability Sixpack.

Step 3: From the dropdown menu, select Normal or Non Normal

analysis based on whether your distribution is normal or non-normal

Step 4: Click on non-normal (or normal), enter the details required for

conducting the capability analysis and then click Ok.

Once we click ok, Minitab generates the process
capability in a separate window.

You will in fact, find many video lectures also available 3 minutes to 10 minutes on
YouTube that can also help you to appreciate the mini tab application. A good mini tab

support is also available online and you can see various examples. So, from those



sources | have taken some of the examples to discuss with you and we will appreciate

how we can conduct the process capability analysis in mini tab.

So, the steps goes like this, step 1 go to file menu click on open project and then load the
required data. You may have a data in excel sheet you can import the excel sheet or you
can just copy paste the data transfer the data in the new project file. Step 2, go to start
menu move to quality tools and then capability analysis or capability six pack. So, here
you will find two options capability analysis and second is capability six pack we will
see. So, this is a say commercial version, commercial software and to suit and meet the
requirements of the industry, they are offering two different kinds of options process

capability analysis and process capability six pack analysis.

Step 3 from the drop down menu select normal or non-normal analysis; at this stage we
will only talk about normal, subsequently in the next lecture we will talk about non
normal process capability typically when my data is not normally distributed then how to

deal with this and how to conduct the analysis in mini tab.

So, once you have selected the normal here in this case and typically whether your
distribution follows normal or non normal. So, there are various ways and means the
simplest way is to look at your histogram and that will at least give you some say inside
that to what extent your data is symmetrically normally distributed or it is skewed on
either side or it follows some other distribution. But there is normal probability plot and
when you plot your data on this, that will clearly give you the guidelines that yes your
data is normally distributed or not. So, we will see such kind of graphs also in this

lecture.

Step 4, click on non normal or normal for this lecture, as I mentioned let it be normal,
enter the details required for conducting the capability analysis click ok and the moment

you will click ok mini tab will generate the various results outputs in a separate window.
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Minitab: Process Capability Analysis
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So, just see this and you will find it interesting that, what are the a say outputs your
typical mini tab will generate when you are pressing and selecting process capability six
pack analysis. Six pack here means you will allow six different results analysis present

date and all are very much useful.

If you see the first one individual value I chart, then this helps you to understand that
whether there are some outliers or some of the say readings they are falling typically
outside the upper control line or the lower control line. So, if you recall I emphasize that
in order to conduct your process capability analysis, your process must be in a state of
statistical control and if this particular graph for individual shows that it is not within
control or some of the outliers are there, you can exclude the outlier or first you can

bring the process into the statistical control.

So, that whatever variation you absorb that is mainly within this control limit and control
limit statistically it is x bar plus or minus three sigma. So, you have the standard
deviation value, this is your x bar and when you put it as plus or minus 3 sigma, you get

the typical upper control limit and the lower control limit.

Now here I can see that all the points are within and I can have a fair assumption that my
processes within the statistical control. Similar way you also check for the range because
many times only individual observation cannot help me, we always talk about the center

or location of the process and dispersion. So, variability I can capture through this



particular moving range chart and that will help me to understand that whether my
readings for range are within the prescribed limit that is the control limit or some reading
is going out. So, here you can see that one of the reading is going out and if there is some
assignable cause, special cause you can actually remove this cause and bring your

process into the statistical control.

Then you have various observations and value plotted. So, this graph will just give you
an idea that whether your observations they follow a random pattern or there is some
kind of trained available. So, this is your 25 observation chart, now you can see here that
you have the capability histogram and you have specification LSL 75 USL 105. So, this
histogram as you can see will help you to appreciate that to what extent your assumption
about normality is true and whether your data follows the normal distribution or not. If it
is not then you must go for the non normal process capability analysis that we will

discuss in the next class.

Now you can see the another one that normal probability plot and what you can see here
that you have the readings plotted here, all these readings in red dot and suppose if I put
a pencil or pen, and if it covers all the readings on normal probability plot then I would
say that my readings they form or my observations they follow the normal distribution

and my assumption about normality is true. You can have capability plot also.

So, typically this is the end result that we are looking for. So, we have standard
deviation, we have pp we have Ppk on this side you can see standard deviation Cp and
Cpk and you can easily make a conclusion that Cp 1.12. So, technically it is greater than

1 and your processes capable similar way your Cpk is 1.1. So, it is capable.

When I look at the long term this is my long term then, Ppk and Pp value are also greater
than 1. So, I would not say its a six sigma process, but for because for that I need to be
close to 2, but fine technically greater than 1 it means my processes are capable in terms
of performance, that is the spread variability in terms of potential Ppk in terms of
location or shift in the center value or the location. So, this is a very helpful analysis and

you can do it very easily in mini tab and interpret the results also.
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Minitab: Process Capability Analysis

* Minitab has many tools that will help you in this area. We will find Process Capability under:

Stat>Quality Tools> Capability Sixpack> Normal

Open Linel. MTW in the Minitab Datasets Folder and go to the Capability Sixpack

Now, the process which we follow in mini tab I have already discussed the steps. So, you
have statistics the package statistics, quality tools, capabilities six pack and then normal
because my assumption is that it is normal, but definitely I would like to verify it through
histogram as well as normal probability plot, and then I can open some file for getting
the data input or for importing the file to my mini tab and then I can conduct the minitab

six pack process capability analysis.
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So, I was shown here with a clear cut idea that, this is the quality tool, then once you will
have here you will have a drop down menu, you will have capability six pack and then

you select normal. So, its a very simple and easy to follow procedure.
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Minitab: Process Capability Analysis

Enter the data you have and select OK
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Once you have done this then you will have some datas to be say inserted and here you
can see that there is single column subgroups sizes 1 and you need to enter this lower
specification limit and upper specification limit. If you make mistake in say inserting the
data, you will get asterisks; asterisks means because of certain reason we could not
conduct or software could not compute the value and we have to be careful in inputting

inserting these values properly.

So, this is the six pack analysis that you have seen and we have discussed all the

importance of all the six charts.
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Example

Calculate the capability indices - C, C;, C;,, and C, for the process for
which the data are given below using MINITAB. The process has sup-
group size of 5 and 125 data points.

USL = 10.050, LSL = 9.950,  =9.999 and 6=0.0165

\'4 A

Now, let us take the example and try to also solve it using the mini tab. So, calculate C p

C pl C pu C pk for the process which the data given using the mini tab and the processes
subgroup size 5. So, each particular sample you have 5 units its a subgroup size and 125
data points are there you have USL upper specification limit 10.0250, you have LSL
9.950 and you have mu 9.999. So, you have the data set you can compute this and you

out sigma 0.0165.
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Capability Analysis through Minitab Example

Capability analysis can be done in two ways
Vl’. Through stat->quality tools->capability sixpack
\2{ Through stat->quality tools->capability analysis

The following slides will show both ways



Now, as I mentioned you can do two kinds of analysis, number 1 you can go to stats
quality tools and capabilities six packs. So, it will give you six different outcome, each
one will help you to appreciate the data and the results and comment on the capability of
your process, and second is through stat quality tools and capability analysis. So, now,

we will see in the subsequent slides how to carry out this exercise.
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Through Stat->Quality tools->Capability

So, first let us say capability six pack.

(Refer Slide Time: 14:54)
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So, I have this particular window; this is step one import data in the work sheet of the

mini tab application and it is like excel sheet only.

(Refer Slide Time: 15:04).

Step 2: Select Stat->Quality Tools->Capability
Sixpack->Normal

Then you have capability six pack. So, from quality tool you go to capability six pack, I

am elaborating it and then you select the normal.

(Refer Slide Time: 15:15).

A New window will appear
Step 3: Select the data as shown in the new window
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Then you put the data lower specification, upper specification, mean standard deviation

and you press the ok.
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Click OK ->You will get the Sixpack Result

< b U L gt B s
Process Capability Sixpack Report for Data

TR e
L 1§ St Capatsing s
. w -

s

S et e

' e g0t :
R LU (T = e =1

| NG i B

1 .:Il:', G FILE

So, you will have six different charts of graphs in front of you and as I mentioned that
these two will help you to understand whether my process is in control or not, this will
help you to understand whether my data is randomly scattered or there is some pattern

available.

This tool will help you to understand whether my data is normally distributed or not, and
this will basically give you the value of your process capability short term that is C pk C
p and long term it is P pk P p and so on. Now you can use the other option that is simple
quality tools capability analysis. So, once again import the data, then go to quality tools
capability analysis and select the normal. Once this is done once again you insert the
values of your upper specification limit, lower specification limit mean and the standard

deviation and your sub group size 5.
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Click OK ->You will get the Result
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So, you will have the different analysis window or different graphs available, not like six
pack where you are getting six different graphs in one window. Here it will generate first
let us say process capability report for the data and you can interpret very easily this is

the overall capability and this is the within capability.

So, this is your long term this is your short term and you can see that Pp value PPL value
PPU Ppk Cpm as well as C p all these are greater than one. So, my process in this way is
capable, but if you see the C pl its point ninety nine its almost it is 1, but by chance if it
is low then it would say that I have a little less capability when I look at the lower
specification limit otherwise my C pk C pu C pk more or less they are one or very close

to 1 so my processes capable.



(Refer Slide Time: 17:47)

+ v Copoety Bt e

Process Capability Report for Data
{using 95.0% confidence)

DnDeviwithing Q.05

934 9% 936 000 W0 M

Periormancy
Obsirved  Lepicted Overal  Lxpécticd Witkin
S L o L]
L] 1] [
] on o

You will see another report that is 95 percent confidence and we will see in hypothesis
testing, but many times I want to conduct the confidence interval and want to see that my
specific value of interest, does it fall into that confidence statistical confidence interval or

not.
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Example

Souree;: Six Sigma Quality: Concepts & Cases- Volume I_STATISTICAL TOOLS
IN SIX SIGMA_DMAIC PROCESS WITH MINITAB APPLICATIONS

We want to assess the process capability for a production process that
produces certain type of pipe. The inside diameter of the pipe is of
concern. The specification limits on the pipes are 7.000 £ 0.025 cm.
There has been a consistent problem with meeting the specification
limits, and the process produces a high percentage of rejects. The data
on the diameter of the pipes were collected. A random sample of 150
pipes was selected.

So, here you can see that this particular say graph has given you Pp, but confidence
interval for Pp. It means this says that I am creating the confidence interval for 95

percent. So, please remember that statistics is basically based on the random phenomena,



chance phenomena and we try to take the sample and based on that we try to derive the
inferences. So, we cannot be sure 100 percent, we have to make certain assumptions as
well as we have to work within with certain probability. So, here I say that 95 percent
confidence I have that my value pp value will fall in the range of 0.90 this is the one I am

referring to 1.16.

So, I have 95 percent confidence in my result that my P p value will fall within this
interval 75 percent of the time similar way I would be interested to see that what is the
confidence interval for P and your P pk value is 1.01, but if you conduct a study number
of times you would find that find for different subgroup or for different window of time
you will have different, P pk value, but with 95 percent confidence I can say that my P pk
value will fall within 0.88 to 1.13.

So, this is something that is additional, we can do in the process capability analysis and
we can create the confidence interval for various indices. So, just see the example here to
strengthen your understanding, we want to assess the process capability for a production
process that produces certain type of pipe and typically the inside diameter is the CTQ
Critical To Quality, the quality characteristic in which I am interested and that is of

concern.

So, specification limit for this is 7 plus or minus 0.25 mini tab centimeter and there has
been a consistent problem with meeting the specification limits. So, you are encountering
the rejection and now I want to see that whether my process is really capable or not. So, |
took the random sample of 150 and I measured the inside diameter and then I am trying

to conduct the process capability analysis.
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Solution Steps

¥ Generate random data using Excel sheet with upper limit as 7.025 and lower limit as 6.975.

Use the command sequence Stat &CQuality Tools & Capabllity Analysis &Normal

In the Data are Arranged as section, click the circle next to Single ealumn and select or type C1 Pipe Dia in the box
Type 1in the Subgroup size box

In the Lower spec. and Upper spec. bowes, type 6.975 and 7.015 respectively

Click 0K

Click the Options tab on the upper right corner

Type 7.000 in the Target (adds Cpm to table) box

In the Calculate statistics using boi a 6 should show by default

Unld:r lf!:ﬂrm Analysis, Within subgroup analysis and Overall analysis bowes should be checked (you may uncheck the analysis
not desir

S Y S T

-

Under Display, select the options you desire (some are checked by default)
¥ Type atitle if you want or a default title will be provided
¥ Click 0K in all dialog boxes.

@

So, you can see the steps it is same as [ mentioned that you open the window, import the

[T ..—ma i

data or copy paste the data, say define the subgroup size also enter the upper and lower
specification, limit your standard deviation and mean value and then you just try to click
ok if you want to conduct six pack analysis choose that option. If you just want to go for

process capability analysis choose that option and that would serve your purpose.

So, this is the initial window where I put the data, this is the pipe data you can see in first
column, and then say second window I am going. So, capability analysis [ am choosing
and that is normal I am entering the data of LSL USL sigma mu and then I am also

putting the target.
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So, we discussed C pm and this particular target related indices is also called Taguchi
capability index, here I am specifying my target value and with respect to that I want to

conduct the analysis.
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So, once this is done you can figure out that exactly what is happening with your process
and just see these values you have Pp 0.96, you have PPL 1.35 PPU 0.56 Ppk 0.56 and
Cpm 0.61.



So, excluding PPL that is on the say lower side, all other values are less than 1 and
clearly it indicates that your process has problem. Now if you see the PPL this is quite
good 1.35. So, you have a comfortable zone towards lower specification limit and if
there is a need to readjust your center to the target or to some value, then you can little
bit more towards the lower specification limit and you can try to control the scrap which

is increasing your cost.

But this is a short term measure for long term; obviously, you have to correct the setting
if there are worn out parts you have to replace them if there is an issue with the operator
skill, you have to train the operator and likewise you have to take the long term actions

also.
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So, this is 95 percent confidence and same way you can see that what is the band,
statistical confidence interval band within which at 95 percent confidence my Pp will fall

my Ppk will fall and so on.
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Caution! - Why are some capability analysis results
shown as asterisks in the output?
+ |f a capability index cannot be calculated, Minitab inserts an asterisk

(¥) next to the index in the capability analysis results.

+ If you see an asterisk in your output, it may be due to one of the
following reasons.

Reason 1: Only one specification limit

If you enter only an upper or a lower specification limit, but not both, Pp
and Cp indices cannot be calculated. Pp and Cp are both calculated using
the distance between the lower and upper specification limits. If only
one specification limit is entered, that distance does not exist, and Cp
and Pp values cannot be reported.

@

So, you have certain cautions and I mentioned that if you do not enter the data properly,

[T E e -«:»-'a ~1

your mini tab output will show you the asterisks for some of the indices or some of the
results, and this asterisks indicates that either reason number 1, only one specification
limit. So, if you have entered only one specification limit, but not both then typically

your Pp and Cp were USL minus LSL is required that will show you the asterisks.

(Refer Slide Time: 24:51)
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Caution! - Why are some capability analysis results shown as
asterisks in the output?

Reason 2: No target

If you do not enter a target for the analysis, Cpm cannot be calculated. Cpm is a
capability index that measures whether the process meets specification and is on
target, by taking into account the data's deviation from the target value. If no target is
entered, that deviation does not exist, and Cpm cannot be reported.

Reason 3: Two boundaries

If you select both specification limits as boundaries, all capability statistics will have
asterisks (*) instead of values in the output.

You should only use a boundary when it is not possible for data to exceed that

specification limit. For example, if you record downtime for a piece of equipment, a
lower specification of zero should be checked as a boundary because negative
downtime is not possible.

Similar way you know target. So, if you do not enter a target for the analysis what is your

target value? Cpm cannot be calculated because this is Taguchi process capability index



which demands that, you should specify the target. If you are not interested in that kind
of analysis fine you may not enter, but otherwise it will show you the asterisk. Two
boundaries, if you select both specification limits as the boundaries, all capabilities

statistics will have asterisk instead of values in the output.

So, here you are creating the boundaries selecting the boundaries as the specification
limit and you should only use a boundary when it is not possible for data to exceed that
specification limit. Just to share the example if you record downtime for a piece of
equipment, a lower specification of 0 should be checked as a boundary because negative

downtime is not possible.

So, some time to restrict my data within a particular range, negative downtime has no
value no importance no significance would be interested to specify the boundary, but
defining a logical boundary leads to say inability of the software to give you the result
and then it will show you the asterisk. So, to end this session, I would like to float couple

of questions as think it.
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. What are the steps to conduct a Process Capability Analysis
using Minitab Software?

2. What is Capability Sixpack? Describe each features of
Capability Sixpack and how to interpret the output of
Capability Sixpack of Minitab Software?

3. What are the features of Capability Analysis in Minitab
Software?

4, Distinguish Capability Analysis and Capability Sixpack in
Minitab Software with their advantages over each other.

So, you have certain steps to follows in mini tab can you just summarize this steps once
again. What is the capabilities six pack described the features of this and how do you
interpret the various outputs of six pack? What are the features of capability analysis in

mini tab software and we discussed already that can you distinguish the capability



analysis simple and capability analysis six pack in mini tab software with couple of

advantages and disadvantages over each other?
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capability-analysis/before-you-start/overview/

So, I have highlighted here couple of links from where I use the example, I took the
example you can also further refer it, you can refer the mini tab support or you can put
process capability analysis in mini tab in YouTube and you will also get some of the

good useful videos.
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Conclusion:

*+ Capability analysis reveals how well the
manufacturing process meets these specifications,
and provides insight into how to improve the process
and sustain the improvements

% Minitab is a popular tool that allows one to perform

various statistical calculations such as normality test,

!
\=

process capability analysis and so on. m



So, conclusions about the capability analysis we have devoted almost a three lectures on
process capability analysis, because a bad system will beat the right person every time.
So, I must check that whether my process is capable or not and if not first correct the
process improve the capability instead of putting your effort or taking the action in the

wrong direction.

So, capability analysis reveals how well the manufacturing process meets this
specifications and provides insight into, how to improve the process and foster
improvement and mini tab typically is a popular tool which allows one to perform
various statistical calculations such as normality test non normal process capability and

SO on.

So, thank you very much for your interest in learning this particular session on process
capability analysis with the use of mini tab, I would advise that either you take the same
data or some other data or some random data and put it in the say mini tab software new
project file, and conduct the mini tab analysis as advise this will really help you to gain
the confidence in the use of software. So, keep revising, keep introspecting refer the

suggested text and sources to strengthen your understanding and be with me enjoy.



